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Trademark Notices 

IsWhere® is a trademark of Red Hen Systems, LLC. 
 
All other trademarks listed in this document are the property of their respective owners. 
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Technical Support 
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Preface 

Who is this guide for? 

This User Guide is for anyone who will be installing or using the isWhere application. If you are reading 
this, you are probably one of the following types of people: 

 Vehicle drivers, air pilots, and boat pilots with or without GIS or photography skills. 

 Operators who are skilled with GIS equipment and cameras, but do not necessarily pilot the vehicle, 
aircraft, or boat. 

 People in the energy, natural resources, defense, security, or travel industries who need to collect 
data for inventory, tracking, maintenance, security, or planning purposes. 

 People who need to examine media collected on land, air, or sea – to see the route that was 
followed as well as view the videos and photos. 

 

Why read this guide? 

This guide provides you with step-by-step instructions for using isWhere, as well as trouble-shooting tips 
and configuration instructions that can help you when you’re viewing certain videos.  
 

How is this guide organized? 

This manual is organized for ease-of-use to make things easy to find and read. This means it starts with 
installation instructions and a basic overview of the interface. Then it delves into important tasks you 
can perform, proceeds with trouble-shooting tips in case you encounter problems, and ends with some 
advanced instructions for configuring codecs so you can view high-definition videos from the Panasonic 
AG-HMR10 recorder. 
 

 

What’s New?  

 
If you’re someone who’s been using isWhere for a while, you’ll probably be interested in 
what’s new in version 3.1. 
 

 

 QR Code: When you hover over a location on a track on Google Earth you see the information 
popup window with details about the location. The popup now contains a QR code that can be 
scanned by a Smartphone app, allowing the individual with the phone to see the location on Google 
Maps on their own phone. For details, see Get detailed information about a location in Google 
Earth. 

 Field of View: If photos were captured in tandem with Laser Range Finder measurement, you can 
now see a field-of-view rectangle wherever the photo was captured on Google Earth. You can also 
see lines representing the Laser Range Finder measurements between camera and object. For 
details, see View a photo with Laser Range Finder information associated with it. 

 Video Clipping: isWhere no longer supports video clipping because there are several other free, 
quality programs that do so exceptionally well and ensure the GEM track stays intact after the video 
is clipped. VLC is one such program. 



isWhere User Guide 
Version 3.1 

5 
Copyright © Red Hen Systems 

 

Section 1. Introducing isWhere 

The isWhere desktop application lets you open and view geotagged videos and photos, capture 
individual images and video clips from geotagged videos, and observe the route where the media was 
captured on Google Earth. 
 
With isWhere you can use VLC or Windows Media Player to play all the existing video formats, both 
standard definition (SD) and high-definition (HD). IsWhere decodes geospatially-encoded media (GEM) 
videos and creates the associated sidecar KML and XML companion files. These are the files that help 
create the track (route) that you see on Google Earth. 
 
As the video plays in VLC or Windows Media Player, the track is visible in Google Earth. A moving cursor 
travels along the track, showing you exactly where the current video frame is located. Additionally, 
colored icons in Google Earth indicate features of interest captured during data collection. If a Laser 

Range Finder was also used during data collection, a target icon  will appear in Google Earth 
indicating the locations of targets “shot” by the Laser Range Finder.  This illustration shows an aerial 
view of part of Colorado State University.  

 

 
 

Note: “LRF crosshair”  is hidden under the base of the information pop-up. The crosshair shows the 
location of the Laser Range Finder target. You can see the aqua “rays” aimed toward that location. 

isWhere 

Google Earth 

Feature of 
interest 

LRF target 

Information 
pop-up  
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Section 2. Getting Started with isWhere 
 
Before You Begin  

Please make sure you: 

 Have installed Google Earth on your computer. 

 Have installed the most recent Windows updates on your computer.  

 Will be using Windows Media Player (WMP) the default media player for the Windows operating 
system.  

 
The rest of this section offers step-by-step instructions for carrying out isWhere tasks. 
 

2.1 Install and start up isWhere 

1. Before you install the software, make sure your computer meets the minimum requirements:  

Operating System Windows 7 or above 

RAM 2 GB 

Hard drive space The software occupies less than 70 MB; however, you need enough space to 
store all your photos and videos (this varies according to you situation) 

 
2. Click the download link you received from Red Hen Systems. 
3. The installer starts running and attempts to install all the prerequisite software packaged with it 

(.NET Framework 4.5, Visual Studio 2010 Redistributables. 
4. Respond to the installation prompts as they appear. 
5. When the installation completes, you will receive a message and the isWhere icon will appear on 

your Desktop. 
6. Double-click the icon to start isWhere. 
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2.2 Get familiar with the isWhere interface  

Once you start up isWhere, its interface appears, along with Google Earth. It’s a good idea to get familiar 
with the isWhere interface before you continue.  

 

1. The isWhere interface consists of a toolbar with several icons along the top, and tabs that open, 
depending on which toolbar icon you select. 

 

 

2. Each tab or button produces lets you do the following:  

Tab or Button Description 

Open Media tab 

 

Load media from a project and select a file to view. If the file is a 
geotagged video, watch it in VLC or Windows Media Player, as well as view 
the track (route) where the video was captured on Google Earth. If the file 
is a photo, view its location on Google earth and click to open the photo. 

Edit Video tab 

 

Create video clips or still photos from a video, capture features of interest 
as screenshots, or add subtitles to a video. 

Options tab 

 

Set options associated with isWhere, the video, and its track on Google 
Earth. 

Help button 

 

Access the isWhere User Guide in PDF format or get information about 
support and the latest release. 

Details about the different tabs and their fields follow. 



isWhere User Guide 
Version 3.1 

8 
Copyright © Red Hen Systems 

 
 

3. Using the Open Media tab 

The “heart” of isWhere is the Open Media tab. This is where you open projects and select geotagged 
photos and videos to view. Here are two terms used in this section and throughout this User Guide that 
are useful to know: 

 Project. A group of geotagged photos and videos associated with a particular data collection event.  

 Media list. The list of photos and video listed on the Open Media tab. 
 

Before You Begin: If this is the first time you have used isWhere, you will need to set the options using 
the Options tab, which is discussed in Section 5. Using the Options tab. 

3.1 Load a project  

The media list in the Open Media tab consists of a list of names of geotagged media file. These are files 
you can view, one at a time. When you first start isWhere, there will be no videos or photos in the media 
list.  You can either load the media list with all the media files in a particular project, or load individual 
media files.  To load an entire project, follow these instructions. 
 

1. Open the Open Media tab.  
2. To make it easier to find a video or photo, you can sort the files in the media list in the following 

ways:  

 

 Alphabetically (A-Z). Sort in normal alphabetical order 
 Alphabetically (Z-A). Sort in reverse alphabetical order 
 Date (Newest first). Sort in chronological order. 
 Date (Oldest first). Sort in reverse chronological order. 
 File Type. Sort by type (videos, audio, and photos) 
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3. Click the Load Project button next to the media list. The Load Project dialog appears.  

 
a. Navigate to the appropriate project file (*.rhproj). It contains geotagged photos and Red Hen 

Systems geospatially-enabled videos. Each video has:  (a) GPS information embedded in it (.GEM 
format) or (b) an associated .XML file with the same name that contains the GPS information. 

b. Select the project and press Load. 
4. All geotagged photos and videos in the selected .rhproj file now appear in the media list. By default, 

the media files are listed in the order they were originally added to the project. However, if you 
want to sort them in another way, click the down-arrow next to Sort Media Files to sort: 

 

 Alphabetically (A-Z). Sort in normal alphabetical order 
 Alphabetically (Z-A). Sort in reverse alphabetical order 
 Date (Newest first). Sort in chronological order. 
 Date (Oldest first). Sort in reverse chronological order. 
 File Type. Sort by type (videos, audio, and photos) 

 

WARNING! If you had previously loaded a project, a warning indicates that all existing files in the media 
list will be replaced by the media files in the project you are now loading. This gives you a chance to 
Cancel if you need to.  
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3.2 Add media to the media list  

There may be times when you want to load individual geotagged photos and videos, rather than an 
entire project, or want to add a photo or video to the media list. 
1. From the Open Media tab, click the Add Media button next to the media list.  
2. The Add Media dialog appears. 

 
a. Navigate to the folder containing the photos or videos of interest. 
b. Select one or more media files from the folder. The files must be geotagged because the GPS 

information is essential for the locations of photos and videos to be viewed in Google Earth. 
 The photos you select must be geotagged files in *.jpg format.  
 The videos you select must be Red Hen Systems geospatially-enabled videos. Each video has 

(a) GPS information embedded in it (GEM format) or (b) an associated *.xml file with the 
same name that contains the GPS information.  

Note: To select multiple files, press the Ctrl key as you select the videos or press the Shift key 
and select the first and last file to select all files between them. 

c. Press Add to close the Add Media dialog.  
3. The selected media files now appear in the media list in the Open Media tab. Note: If any of the 

selected files were photos, small camera icons will appear at their locations in Google Earth, along 
with small thumbnails. For details on viewing videos and photos, see Watch a video from the media 
list and View a photo from the media list. 

 

3.3 Remove media from the media list 

If the media list gets too long, you may want to remove photos or videos from the list. 
 
1. From the Open Media tab, go to the media list and select one media file at a time to remove. Note: 

You cannot select multiple files. 
2. Click the Remove Media button next to the media list.  
3. A confirmation dialog asks if you really want to delete those files. Click Yes if you do or No if you 

don’t. 
4. Once deleted, the specified photos and videos will no longer appear in the media list. 
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3.4 Save a project 

Once you have project with the appropriate media for viewing, you can save the project, in case you 
want to view the list of media again. 
1. From the Open Media tab, click the Save Project button next to the media list. 
2. The Save Project dialog appears.  

 
a. Navigate to the folder where you want to save the project. 
b. Provide a name and click Save. All files in the media list are saved to that project. The project file 

itself has the extension *.rhproj. 
3. You can later use Load Project to access the project and its media files. 
 

3.5 Watch a video from the media list  

Watching a video in isWhere is quite simple. 
 

Before you begin: Make sure you have loaded a project so there are photos and videos in the media list. 

 
1. From the Open Media tab, go to the media list and select the video you want to watch. By default, 

the media files are listed in the order they were originally added to the project. However, if you 
want to sort them in another way, click the down-arrow next to Sort Media Files to sort: 

 

 Alphabetically (A-Z). Sort in normal alphabetical order 
 Alphabetically (Z-A). Sort in reverse alphabetical order 
 Date (Newest first). Sort in chronological order. 
 Date (Oldest first). Sort in reverse chronological order. 
 File Type. Sort by type (videos, audio, and photos) 

Note: If you do not find the video you want, you will have to add it to the list. For details, see Add 
media to the media list. 

 
2. When you select a video, the GEM decoder progress bar appears until the GEM decoder has 

extracted all metadata from video (for example sensor or Laser Range Finder data), and transformed 
the information into a format isWhere understands. 
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3. The video now opens in the appropriate viewer – either VCL or Windows Media Player, depending 
on what you specified in the Options tab. For details, see Using the Options tab.   

VLC Media Viewer 

 
 The viewing area takes up most of the screen. The time code for the current video frame       

appears in the bottom-right corner of the viewing area. (HH:MM:SS = hours:minutes:seconds) 

 The controls appear beneath the viewing area. 

Slider bar 
 

Drag the bar forward or backward to move through the video.  

 

  

These are the play and pause buttons. The arrow button starts the video. The 
button then turns into double vertical bars so you can pause the video.  

  
Starts playing the previous video in your media list.  

  
Stops the video from playing and returns the slider bar to the beginning.  

  
Starts playing the next video in your media list.  

  
Toggle to full-screen mode (for videos only).  

   
Show extended settings: Audio effects, Video effects, and Synchronization).  

  
Show media list.  

  
Repeat: Toogles between Loop All (repeat entire list), Loop One (repeat 
current video), No Loop (do not repeat)  

  
Random: Plays the files in the current media list in a random order.  

 

Adjust the volume of the audio.  
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Windows Media Player 

 

 The viewing area takes up most of the screen. The time code appears in the bottom-right corner 
of the viewing area (05:05 in this example).  This is the current video’s reference time. 
(HH:MM:SS = hours:minutes:seconds) 

 The controls appear beneath the viewing area. 

Slider bar Drag the bar forward or backward to move through the video. 

 

   
These are the play and pause buttons. The arrow button starts the video. The 
button then turns into double vertical bars so you can pause the video. 

 Stops the video from playing and returns the slider bar to the beginning. 

 Starts playing the previous video in your media list.  

 Starts playing the next video in your media list. 

 Adjust the volume of the audio. 
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4. Once you select the video, its track appears on Google Earth, showing the route taken where the 
video was recorded. This illustration shows a video of a winter drive around the Oval at Colorado 
State University.  

 
 

a. The moving cursor on the track indicates the location of the current video frame you are 
viewing.   

b. The track is actually a series of arrows. When you click a location (arrow) on the track, an 
informational pop-up appears with a link at the bottom: Play video from current position. 
When you click this link, the video automatically jumps to the location indicated in Google Earth. 
Note: You cannot drag the track cursor in Google Earth. 

c. For details about any point on the track, see Get detailed information about a location in 
Google Earth. 

isWhere 

Google Earth 

moving 
cursor 

video track showing 
location of moving cursor 

LRF 
crosshair 
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3.5 Get detailed information about a location in Google Earth  

Once you’ve loaded a video, its track appears on Google Earth. To get detailed information about any 
point on the track, hover over the point an informational pop-up appears with the following 
information:  

 
 Date: Date the video was recorded. 

 Latitude. Latitude of the current video frame. 

 Longitude. Longitude of the current video frame. 

 AGL. Above Ground Level. If the video was captured from a helicopter with a Laser Range Finder 
(LRF) pointing at the ground, AGL will reflect the elevation of the LRF target above the ground. If no 
LRF was used, the AGL value will be 0 (zero). 

 Time Code: Time associated with the current video frame (HH:MM:SS = hours:minutes:seconds). 
This is the same time that is displayed in the bottom-right corner of the video viewing area. 

 Play video from current position: Click this link to make the video to jump to the current location. 
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 QR Code: If someone is watching the video with you, they can use a scanning app on their 
Smartphone to scan the QR code on the screen. This produces a URL they can click to bring up 
Google Maps on their own phone and view the scanned location. Note: If you turned off the QR 
Code from the Options tab, you will not see the code on the informational pop-up. 
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3.6 View one a photo from the media list 

Before you begin: Make sure you have loaded a project so there are photos and videos in the media list. 

1. From the Open Media tab, go to the media list and select the photo you want to view. By default, 
the media files are listed in the order they were originally added to the project. However, if you 
want to sort them in another way, click the down-arrow next to Sort Media Files to sort. 

 

 Alphabetically (A-Z). Sort in normal alphabetical order 
 Alphabetically (Z-A). Sort in reverse alphabetical order 
 Date (Newest first). Sort in chronological order. 
 Date (Oldest first). Sort in reverse chronological order. 
 File Type. Sort by type (videos, audio, and photos) 

Note: If you do not find the photo you want, you will have to add it to the list. For details, see Add 
media to the media list. 

2. Once you select a photo from the media list, Google Earth moves to the location where the photo 
was taken. You will see a camera icon and a thumbnail photo at that location. This illustration shows 
thumbnail photos of rice paddies in Bali.   

 
3. To view a full-size version of the image, double-click the camera icon or the thumbnail; then use 

your mouse wheel to zoom in and out of the larger photo. Note: To exit full-size view mode, click 
the Google Earth Exit button in the upper-right corner.  

Google Earth 

Photo 
thumbnail 

Camera 
icons 

isWhere 
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3.7 View a photo with Laser Range Finder information associated with it  

If a Laser Range Finder was connected to a Red Hen Systems VMS-333 or DMRT, any captured photos 
will have Laser Range Finder (LRF) information associated with them. As a result, the photos will appear 
differently on Google Earth. 
1. From the Open Media tab, go to the media list and select the photo you want to view. By default, 

the media files are listed in the order they were originally added to the project. However, if you 
want to sort them in another way, click the down-arrow next to Sort Media Files to sort. 

 

 Alphabetically (A-Z). Sort in normal alphabetical order 
 Alphabetically (Z-A). Sort in reverse alphabetical order 
 Date (Newest first). Sort in chronological order. 
 Date (Oldest first). Sort in reverse chronological order. 
 File Type. Sort by type (videos, audio, and photos) 

Note: If you do not find the photo you want, you will have to add it to the list. For details, see Add 
media to the media list. 

2. Once you select a photo from the media list, Google Earth moves to the location where the photo 
was taken. You will see: (a) the camera icon showing the location of the camera and LRF, (b) the LRF 
measurement line showing the distance between LRF and the photographed object, and (c) the 
field-of-view rectangle on the ground for the photographed object. 

 
3. IsWhere is aware of the embedded Laser Range Finder information and will paint a field-of-view 

rectangle on the ground, as well as display the Laser Range Finder measurement line. The 
measurement line shows the distance between the camera and the photographed object. 

(b) LRF Measurement Line 

(a) Camera location 

(c) Field of View Rectangle 
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4. To view a full-size version of any image, double-click the camera icon or the thumbnail; then use 
your mouse wheel to zoom in and out of the larger photo. Note: To exit full-size view mode, click 
the Google Earth Exit button in the upper-right corner.  

 

3.8. Transfer files from a mobile device to your local computer 

If you earlier captured geotagged photos and videos using MediaMapper Mobile or VMS-Mobile on your 
mobile device, you can easily transfer them to your local computer. This includes transferring files 
directly from the mobile device or transferring them via a removable external SD card.  

Note: Once the files are transferred, use Add Media to add them to the media list. 
 

Before You Begin: Make sure you have the mobile device containing the geotagged videos and photos 
captured by MediaMapper Mobile or VMS-Mobile. Otherwise, make sure you have stored those 
geotagged videos and photos on MediaMapper server.  
 

1. From the bottom-right corner of the Open Media tab, click the Mobile Transfer button. 

2. The Mobile Transfer dialog appears.   

 

 

Note:  

If you press the red question 
mark icon in the upper-right 
corner, a Help dialog appears, 
explaining the difference 
between the various options. 

Details of those differences 
follow. 

a. USB MPT Mobile Device. If the videos and photos are on a mobile device and you want to 
transfer them from the device’s internal storage area, do the following: 

 Turn off the mobile device and then turn it on again before plugging it into the USB port. 
This ensures that the latest media files collected with the mobile device will be visible in 
Windows. 

 Select the USB MPT Mobile Device. The device name should appear.  

 Continue with Step 3. 
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b. Windows Drive (SD Card). If the videos and photos are on an SD card that you plan to remove 
and plug into a card reader, do the following: 

 We strongly recommend you turn off the mobile device before removing the SD card and 
inserting the card into the card reader. This avoids possible corruption of the media files 
present on the removable SD card. 

 Select the Windows Drive option and scroll down to select the correct drive on your 
computer that represents the card reader.  

 Continue with Step 3. 

c. Connect via WiFi. Mobile devices with MediaMapper Mobile installed can use the inbuilt HTTP 
Web Server feature and a WiFi wireless connection to transfer videos and photos from the 
mobile device. To use the WiFi option do the following: 

Note: Make sure to start the MediaMapper Mobile HTTP Web Server from the MediaMapper 
Mobile Setup screen on the mobile device before selecting this connection option. 

 Select Connect via WiFi. 

 Enter the IP Address of the MediaMapper Mobile HTTP Web Server. 

 Enter the Port Number shown in the MediaMapper Mobile HTTP notification screen. 

 Continue with Step 3. 

3. Go to the Destination Folder field in the dialog and click Browse. 

a. Navigate to the folder where you want the files transferred and click Open.  

b. The folder name now appears in the dialog. 

c. Check the checkbox beneath the destination folder if you want the media files deleted from the 
mobile device after they are transferred to your local computer. 

4. Press Start Transfer. A status message appears at the bottom of the dialog with a moving progress 
bar showing the progress of the transfer. When the transfer completes, the bar stops moving and 
this message appears.  

  

The transferred files are copied to different locations on your local computer depending on where 
they came from. 

a. MediaMapper Mobile files transferred directly from the device’s internal storage area will be 
copied to: 
[destination folder]\ MediaMapperMobile 

b. MediaMapper Mobile files transferred from the external SD card will be copied to: 
[destination folder]\Android\data\com.MediaMapper.Mobile\files\MediaMapperMobile 

Note: The lengthy pathname is mandated by Google. 
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c. VMS-Mobile files transferred directly from the device’s internal storage area will be copied to: 
[destination folder]\VMSMobile 

5. When the transfer completes, you’ll return to the Open Media tab. Then click Add Media to add the 
transferred files to the media list. For details, see Add media to the media list. 
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Section 4. Using the Edit Video tab 

The Edit Video tab is the “work horse” of the application. If you are interested in doing more than just 
viewing videos, the Edit Video tab is where you will do you work. From the Edit Video tab, you can 
perform five different tasks associated with editing video: 

 Capture the current video frame as a still photo. 

 Capture video frames (still photos) at intervals. 

 Create a video clip.  

 Add subtitles to the video. 

 Capture features from the video as still photos. 

 

4.1 Capture the current video frame as a still photo  

1. Open the Edit Video tab and go to the Capture current video frame section.   

 
2. Watch the current video in the video player. When you get to a frame of interest, click the Capture 

Frame Now button.  

3. The video frame is captures as a still photo (*.jpg) and saved in the same location as the video you 
originally opened. The photo has the same name as video, with the time code of the video frame 
appended to the video name. 
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4.2 Capture still photos at intervals  

1. Open the Edit Video tab and go to the Capture frames at intervals section. 

 

 
2. Select the option for intervals: 

 Every X seconds. Captures a still photo at the time interval (X) you specify. 

 Every X kilometers. Captures a still photo at the distance interval (X) you specify. 

3. Click Capture to begin capturing the still photos at intervals. Individual frames will be captured until 

you click the Stop Capture icon .  

 The captured frames are stored as individual photos (*.jpg) in the same location as the video 
you originally opened. Each photo has the same name as the video, with the time code of each 
video frame appended to the video name.  

 WARNING! When you use time or distance intervals, you will generate a lot of photos, which 
occupy a lot of disk space. Make sure to click Stop Capture when you no longer want any still 
photos captured. Otherwise, isWhere will continue capturing photos at the given interval until it 
reaches the end of the video. 
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4.3 Add subtitles to videos  

You can specify the information that will be in a subtitle and the subtitle will then appear in every frame 
of the video. Note: You can create subtitles for any video files, not just the one you are watching. 

1. Open the Edit Video tab and go to the Add subtitles to video section.  

 
2. Click Add Subtitles. The Add Subtitles dialog appears. 
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3. Go to the Import XML section of the Add Subtitles dialog and click Import XML.  

a. Navigate to the folder containing the video you want to subtitle.  

b. Look for the *.xml file with the same name as the video, select it, and click Open. Note: You can 
select multiple sidecar files associated with multiple videos if you plan to create subtitles for a 
number of videos. 

c. The names of the selected files appear in the list on the left-hand side of the dialog.  The list 
clears itself of any previously loaded files. Note: When you begin specifying the metadata tags 
for the subtitle, they will be applied to ALL the files in the list. If you need to remove any files, 
select them and click Remove Selected. If you need to remove all of them, click Clear List and 
start over. 

4. Next, view the contents of a sidecar XML file to decide which metadata tags belong in your video 
subtitle. 

a. Use the File Explorer to navigate to the sidecar file and double-click to open it. 

b. The will probably open in your browser. Leave the browser while you return to the Add Subtitles 
dialog. 

c. Locate the XML tags used for subtitling by going to the <GPSIndex> section of the file.  

5. Return to the Add Subtitle dialog and specify the metatags you want in the subtitle. 

6. Go to the Add Metadata for Subtitle section.  Notice the first three metadata tags in the list: 
utcTime, Lat, and Lon. These items are always available for a subtitle.  

a. Use the <all other> tag only if you want to display all available metadata from the XML file(s) in 
your subtitle; otherwise, remove <all other> and add only the metadata tags you are interested 
in. 

b. To add another metadata item to the subtitle, carefully type the name that item in the 
Metadata field at the top of the metadata list. Make sure the name is typed exactly as shown in 

the <GPSIndex> section of the XML file.  Then click Add .   

c. The item now appears at the bottom of the Subtitle Tags list.  

d. Repeat for as many new items as you want to add to the metadata list. 

7. If you want to remove an item from the subtitle, highlight it in the list and click Remove   

Note: If you make a mistake, you can press Reset  to restore the default list of metadata items.  

8. Once you have the right items for the subtitle, click Save Subtitle. A subtitle file is created with the 
same name as its associated video, plus the extension .asa (Advanced SubStation Alpha). It is stored 
in same folder as the video and the XML sidecar file.   

9. When you have added the necessary metadata tags and are ready to create your subtitle, click the 
Save Subtitle button. A process bar appears at the bottom of the dialog while the subtitle file is 
being created. 

a. Once the process completes, a subtitle file is created with the same name as its associated 
video, plus the extension .ass (Advanced SubStation Alpha). It is stored in the same directory as 
its associated video. 

b. When you are done, click Close to return to the isWhere screen.  
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10. If you create subtitles for the currently playing video and save the subtitle file, you will not see the 
subtitles on the video. You must replay the video after saving your subtitle file.  

Note: If you replay the video and still do not see the subtitles or cannot play the video in the media 
player, it means the video format does not support “soft subtitles” stored in external sidecar files. 
For example, .mts video files require that you use a subtitle embedder to re-encode the video with 
subtitles so they are “burned” into the video frames.  

To get around this issue, you can either:  

 Delete the associated subtitle file to once again play the video. 

-OR-  

 Convert the video to another format, such as .mp4, which does support external sidecar files. 
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4.4 Capture features  

Using isWhere, you can capture features that were marked with the feature trigger during videoing and 
save them as individual photos. 

1. Open the Edit Video tab and go to the Capture features only section.  

 
2. Click Capture Features. 

3. The captured features are stored as individual photos (*.jpg) in the same location as the video you 
originally opened. Each photo has the same name as the video, with the time code of each feature 
(when the feature trigger was pressed) appended to the video name. 
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Section 5. Using the Options tab  

The first time you start isWhere, you will probably want to set your options, since those options affect 
both the video and the track you see on Google Earth as you watch your video. Note: You can change 
the options at any time. 

IMPORTANT! When you first start isWhere, the application remembers the Options settings from the 
previous session and applies them to the first video you open and to the map you see in Google Earth. If 
you change the settings and open a new video, the changes will be reflected in Google Earth. 

1. Open the Options tab.  

 
Set the options as follows. 

2. Default Video Player. Specify the video player you want to use for watching geotagged videos. 

 VCL. This video player does not normally come installed on a PC; you must install it. However, 
unlike Windows Media Player, VLC plays every video format with no codec packs required. 

 Window Media Player. This video player is automatically installed on most PCs. However, it 
cannot handle all video types and generally requires manual adjustment of codecs to properly 
view videos (see Codec Configuration for Playing Panasonic AG-HMR10 Videos in isWhere). 
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3. isWhere Behavior. Specify where you want the isWhere interface to appear. 

 Minimize after loading media. The isWhere interface will automatically minimize as soon as you 
load media and Google Earth appears. You can re-display isWhere by clicking its icon in the 
“tray” at the bottom of the computer screen. 

 Show always on top. The isWhere interface will always remain on top of Google Earth after 
loading media. You can always click the minimize button in the isWhere title bar to minimize the 
isWhere interface. 

4. Google Earth Behavior. Specify how you want to view the geotagged track on Google Earth.  

 Altitude Mode. Determine how you want icons displayed on Google Earth, relative to their 
altitude above the earth  

o AGL (Above Ground Level). If the video was captured from a helicopter using a Laser Range 
Finder (LRF) pointing at the ground, AGL will reflect the elevation of the LRF target above 
the ground. 

 If no LRF was used, the AGL value will be 0 (zero).  

 If the video you plan to view was shot at ground level, you do not have to check this 
checkbox. 

o GPS. This is the altitude from the GPS on the helicopter. It is measured from sea level and is 
not as accurate as AGL when determining how high off the ground you are 

o Clamped to Ground. This places all the icons on Google Earth at ground level on the map so 
that they are not floating in the air; the map ignores altitude. 

 Center Google Earth view on the moving cursor. As the cursor moves along the track, Google 
Earth will continually center its on the cursor’s current position. 

 Display photos in nadir view. Photos on Google Earth will appear as if the camera were pointed 
directly down on them from the air. 

 Generate QR Codes: Display a QR code at the bottom of the information popup that is visible 
when you later hover over a track point on Google Earth. Note: If you turn this off (do NOT 
check the checkbox), isWhere will run faster. 

5. Port Settings. Specify the ports for the VLC media player and for Google Earth (the moving cursor on 
the track is generated from a local port). These ports cannot be used by any other hardware or 
software application. 

6. Map Icon Colors and Shapes. Specify how you want the various icons on Google Earth to look.  
Note:  Make sure the colors you use are highly visible against the Google Earth background.  

 LRF Target. Choose the color and symbol for the icon that represents a laser range finder target 
location. 

 Photo. Choose the color and symbol for the icon that represents where a photo was taken. 

 Track. Choose the color and symbol that represents the track (route) on Google Earth. 

 Cursor. Choose the color and symbol for the cursor that moves along the track. Pick a color that 
will be the most visible against the track. 

 Audio Note. Choose the color and symbol for the location of any audio note that was captured. 
Pick a color that will be the most visible against the track. 

 Feature. Choose the color for the feature of interest icons. Pick a color that will be highly visible 
against the background. Note: You cannot change the symbol. 
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a. When you click the color button, a Color Picker dialog appears where you can change the color 
of the symbol.   

 

b. When you click the shape button, a Symbol Picker dialog appears where you can change the 
shape and the color (except for Feature, where you can only change the color).  
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Section 6. Troubleshooting 

This section offers a brief explanation of Google Earth settings and codecs to provide trouble-shooting 
steps for successfully viewing videos and their associated tracks  with Red Hen Systems IsWhere 
software. 

6.1 Google Earth Cursor and Regional Settings 

If the moving cursor in Google Earth does not appear in the right place, it’s likely you need to change the 
regional settings. For example, suppose you flew a pipeline patrol in Ecuador and are now viewing the 
video track in Google Earth. Unfortunately, the moving cursor appears in the North Pole! 
 
This is often related to the thousands separator and the decimal symbol. If you use a comma rather than 
a period, you will probably experience the cursor problem. A simple change in the Windows regional 
settings will fix this. 
 
In Windows-7: 
1. Click the Additional settings button on the initial screen. 
2. When the Customize Format dialog appears, select the Numbers tab. 
3. From the Numbers tab, you must enter US values for the following two fields so that Google Earth 

properly displays the cursor on the video track:  

Field Value 

Decimal symbol . (period) 

Digit grouping symbol , (comma) 

4. Click OK. The moving cursor should now appear in the proper location in Google Earth. 
 
Note: If you are using a different Windows operating system, use the Control Panel and select Regional 
and Language Options. When the dialog appears, look for the Customize button on the Regional 
Options tab and press it. Then follow instructions 2-4 from above. 
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6.2 Understanding Codecs 
“Codec” stands for “coder-decoder” (the plural is “codecs”). It is a program that encodes (compresses) 
and decodes (decompresses) a digital data stream or signal. A codec shrinks large video files 
(compresses), and then makes them playable again on your computer (decompresses). When you view 
video data in a media player, codecs are used behind the scenes to decompress the video and then 
display the content in the Windows Media Player. Note: For details on how to configure the codecs for 
Panasonic videos, see Section 7: Codec Configuration for Playing Panasonic AG-HMR10 Videos in 
isWhere. 
 

6.3 Understanding IsWhere Videos 
IsWhere lets you view a video AND see the corresponding video track on Google Earth only if the video 
has the standard Red Hen Systems GPS information associated with it.  
 
This means that either:  
a) the video has the GPS information embedded in it (.GEM format)  

–OR- 
b) the video has an associated .XML file with the same name that contains the GPS information. 

If you view any other type of video, you will not be able to see its track on Google Earth. 

 

Note: When you use IsWhere, you will notice its interface has a Use helicopter altitude in Google Earth 
checkbox. When checked, this box refers to the helicopter’s altitude when the video was created and 
indicates that you would like to represent this altitude in Google Earth as above sea level (absolute). 
Google Earth may represent points either as clamped to the ground, clamped to the sea floor, relative to 
the ground, relative to the sea floor, or absolute (above sea level). If the video you plan to view was shot 
at ground level, you do NOT have to check this checkbox. 

 

6.4 Successfully Viewing Videos 

If you have any issues trying to view videos, ask yourself these questions and follow the specified steps. 

Note: If you are trying to play a Panasonic AG-HMR10 Videos, please review the detailed instruction in: 
Section 7: Codec Configuration for Playing Panasonic AG-HMR10 Videos in isWhere 

 
Are you having difficulty locating the video you want to view? 

The IsWhere Select Red Hen Video dialog lets you select the video you want to view.  

1. If you cannot find the type of video from the pull-down list (AVI, MTS, MPG, WMV, etc.) you may 
need to select All Files (*.*) from the bottom-right corner of the dialog. This ensures you can see 
videos of all types. 

2. Select the video you want to view. 
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Are you unable to see or hear the video in Windows Media Player? 

Note: If you have trouble viewing the video in one media player, trying viewing it in another. Use the 
Settings dialog to choose VLC or Windows Media Player. For details see, Using the Options tab. 

Once you locate the video file and select it, you should be able to view it. If you cannot see or hear your 
video, you do not have the proper codecs: no visual means you are missing the video codec; no audio 
means you are missing the audio codec. 

To determine which codecs are required, you need to download and install MediaInfo, a free application 
that analyzes your video file and specifies the required codecs. 

1. Go to: http://mediainfo.sourceforge.net/en 

2. Download MediaInfo and install it. 

3. Run MediaInfo to analyze the video and audio format for your file and determine the required 
codecs. 

4. Once you know which codecs are necessary, search the Web for them, download them, and install 
them. 

5. Verify the codecs installation by viewing the list of installed codecs from Windows Media Player. To 
do so, click: 

Help > About Windows Media Player > Technical Support Information 

Note: If the Help option is not visible, select: Organize > Layout > Show Menu Bar 

You should now be able to play your video files in Windows Media Player.  

 If for some reason you still cannot play them, try installing and reinstalling your Red Hen Systems 
software.  

 If you can play the video files, but they do not play properly, continue answering the following 
questions. 

 
Does your video end abruptly or skip? 

If your video plays, but skips or has inconsistent flow, you may be missing a filter. For example: 
Moonlight-Elecard is required for some *.mpeg video files.  

1. Contact the manufacturer of the recording device for a list of filters. You may be able to download 
the filter from the Web. 

2. Install the filter. 

3. Verify the filter installation by viewing the list of installed filters from Windows Media Player. To do 
so, click: 
Help > About Windows Media Player > Technical Support Information 

 
Does your video show interference or discoloration? 

If your video shows discoloration or interference, there may be a conflict between multiple codecs. 

1. Start removing the currently installed codecs. 

2. Re-install the necessary codecs from scratch. 

Note: Consider searching the Web for codecs packs that actually uninstall and replace codecs for you. 
For example: K-Lite.  
 

http://mediainfo.sourceforge.net/en
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Still having problems?  

The video file may require specific hardware to play, such as a special graphics card, more RAM, or a 
high performance CPU. Sometimes, closing other background applications may help. Please contact Red 
Hen Systems for assistance: 

 Send Red Hen Systems a short, 10–second sample GEM video so we can analyze it. Please use 
Dropbox if possible.   

Warning! Do you plan to put your video on CD or DVD? 

 Putting your video files on a CD or DVD can change the necessary codecs for your video. Any special 
software that performs this process can affect the codec required to play the video file. The video 
could essentially be re-encoded without you realizing it. 

Note: Transcoding a GEM video may cause GEM Metadata content loss. 

 

6.5 Getting More Details 

If you would like more details about codecs, here are some other resources that can provide more 
information about codecs and video files: 

 http://www.videomaker.com/article/15362-video-formats-explained 

 http://en.wikipedia.org/wiki/Codec 

 http://www.webopedia.com/quick_ref/Video_Codecs.asp 

 http://www.masternewmedia.org/the-video-encoding-guide-codecs-formats-containers-and-
settings-explained/ 

 http://www.100fps.com/  (information on Interlacing and Progressive video) 

 

http://www.videomaker.com/article/15362-video-formats-explained
http://en.wikipedia.org/wiki/Codec
http://www.webopedia.com/quick_ref/Video_Codecs.asp
http://www.masternewmedia.org/the-video-encoding-guide-codecs-formats-containers-and-settings-explained/
http://www.masternewmedia.org/the-video-encoding-guide-codecs-formats-containers-and-settings-explained/
http://www.100fps.com/
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Section 7: Codec Configuration for Playing Panasonic AG-
HMR10 Videos in isWhere 

Before You Begin: This section is only necessary if you are using Windows Media Player as your media 
viewer; VLC automatically handles most video types and does not require you to manually adjust your 
computer’s codecs. 

This section explains the process for configuring your codecs to properly play Panasonic AG-HMR10 
videos when you use Windows Media Player. 

Your PC has a system for determining which codecs, filters, and splitters it will use to play your videos. If 
you do not have the required codecs for your video, you will not be able to play your video in isWhere. 
For example, you might have only the audio or video codec, in which case, you would see the video but 
you would not hear it, or you might hear the video but would not see anything.  

 
Instructions 

1. Download and install the following on your PC:  
 Windows # codec pack (e.g. Windows 7 codec pack) 
 Moonlight elecard MPEG-2  decoder for Windows Media Player 

(http://www.elecard.com/ftp/pub/mpeg/decoder/ML_MPG2Dec_2.1.4316.zip) 
 K-lite codec pack (can be found here: https://ninite.com/) 

We recommend these codec packs because of their wide diversity in handling many common video 
types and their flexibility for configuration. 
 

Note:  
 If you have codec packs (for example, Quicktime) already installed on your PC, other than those 

above mentioned above, there is no guaranty that your configurations will take affect. Some 
codec packs may do not allow your attempted changes to carry over.  

 To be safe, uninstall any codec packs you believe may be interfering with your configurations.  

 

2. You will use 3 tools to configure your codecs and filters. These tools were already installed when you 
installed the K-lite codec pack: 
 MediaInfo 
 Codec Tweak Tool 
 GraphStudioNext (x86, not x64) 

 

http://www.windows7codecs.com/
http://www.elecard.com/ftp/pub/mpeg/decoder/ML_MPG2Dec_2.1.4316.zip
https://ninite.com/
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3. Right-click your video file and select MediaInfo  to view the details of your specific video. The 
Panasonic video in the example below  uses AVC  for video and AC-3 for audio.  
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4. Next you need to to determine whether your PC can handle this video type and properly play the 
video.  

a. Start GraphStudioNext (x86). 

b. Click and drag your video file into GraphStudioNext. GraphStudioNext provides a visual 
representation of how the video and audio data streams will be handled by your PC.  

 

The GraphStudioNext graph acts as a “flow chart” showing the order in which your PC will 
attempt to use various codecs. However, the codecs the PC uses may not be the "ideal" codecs.  

If this is the case, artifacts may occur when you try to use these codecs to play your video. You 
may also have limited functionality in isWhere, such as not being able to create video clips or 
capture frames as photos (they might appear as blank images in some cases).  

There are decoders and splitters designed to handle various video formats, but you need to 
discover which codecs will fulfill both your needs and isWhere's. GraphStudioNext allows you to 
specify which codecs to use and in which order for the best viewing of Panasonic AG-HMR10 
videos in isWhere. 

Does your graph look like the imageabove? 
 If it matches the graph, you are done. Your video file can be decoded and played in isWhere.  
 If your graph does not look like the one above, or if no graph is displayed, your PC is not 

configured to handle that particular file. You need to configure your codecs and filters using 
the Codec Tweak Tool. Continue with Step 5. 
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5. Start the Codec Tweak Tool. Its main interface consists of a number of buttons, as shown below. You 
will use the buttons highlighted in Red, working your way up from the bottom. 

 

a. Click Media Foundation to open the Media Foundation dialog.  
 Check the Disable for these formats checkboxes.  
 Select Apply and then Close when you are done to return to the main interface. 
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b. From the main interface, click Preferred Decoders to open the Preferred Decoders dialog. 
 Scroll down and make sure your selections match those surrounded in red in the image 

below.   

 
 

 Same interface, scrolled down. 

 
 Select Apply and then Close when you are done to return to the main interface. 
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c. From the main interface, click Thumbnails to open the Thumbnails Settings dialog. 
 Click Select all. 
 Click Apply and then Close when you are done to return to the main interface. 

 

d. From the main interface, click Preferred splitters to open the Manage Preferred DirectShow 
Source Filters dialog.  

e. Scroll down if necessary to select Use merit for M2TS, .TS, .MPG, and .MPEG formats.  

 

f. Click Apply and then Close when you are done to return to the main interface. 
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g. From the main interface, click DirectShow (x86) to display the Manage 32-bit DirectShow 
Filters dialog.  
 Your settings should be similar to the images below. Do not be concerned if they do not 

exactly match.  
 Disable (uncheck) anything that mentions ffdshow and Haali.  
 Click Apply and then Close when you are done to return to the main interface. 
Note: The Matroska splitter (Haali) is not relevant to your task at hand. The video is a .MTS 
file, not a .MKV. 
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h. From the main interface, click DirectShow Filters to open the DirectShow Filter 
Configuration dialog.  
 Click LAV Audio decoder (x86) to open the Properties dialog.  
 Go to the Formats tab and check the box next to ac3.    

 

 Click OK to close the Properties dialog. 
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i. From the DirectShow Filter Configuration dialog, click LAV Video decoder (x86) to reopen 
the Properties dialog. 
 Go to the Formats tab.  
 Uncheck the boxes for h264, mpeg1, and mpeg2.  

 

 Select OK to close the Properties dialog.  
 Select Close to return to the main interface. 

 
6. Return to Step 4, restart GraphStudioNext and verify that your flowchart graph looks just like the 

one on page 37. If it does not, you must repeat the verious tasks in Step 5 and make adjustments to 
the various codecs, filters, and splitters until the graph looks right. This will ensure that you will be 
able to properly play your Panasonic AG-HMR10 videos in isWhere. 
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Appendix A. Red Hen Systems Beta Software License Agreement  

The isWhere application (“Software”) is developed by Red Hen Systems, LLC (“Red Hen”).  

Red Hen grants you a non-exclusive license to use the Software in accordance with the terms and 
conditions below. By clicking on the "I accept" button of this Agreement, you agree to be bound by the 
terms and conditions below and may install the Software free of charge. 

1. You may use this Software for purposes within the usage scope of Red Hen software. This is a BETA 
version of the product and may not work. 

2. You may make one copy of the Software and related documentation, in whole or in part, solely for 
backup purposes. 

3. Except for the backup copy described in item 2 above, you may not otherwise copy or modify the 
Software or related documentation.  

4. You may not sublicense or transfer the license for the Software or related documentation to a third 
party regardless of whether such sublicense or transfer is free of charge. 

5. It is also prohibited to sell software or hardware created using the Software. 

6. You may not reverse-engineer, decompile or disassemble the Software in whole or in part. 

7. This Agreement takes effect upon your acceptance of the terms and conditions herein and upon 
using the Software, and it will remain effective until terminated. 

8. If you breach any of the terms and conditions herein, Red Hen reserves the right to terminate this 
Agreement and the license of the Software, and may be entitled to recover from you any damages 
suffered by Red Hen. 

9. Upon termination, you must destroy the Software, all related documentation and copies.  

10. You may terminate this Agreement at any time by destroying the Software, all related 
documentation and copies. 

11. RED HEN MAKES NO WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, REGARDING THE SOFTWARE 
AND RELATED DOCUMENTATION OR USE OF THEM. YOU ARE SOLELY RESPONSIBLE FOR ANY 
PROBLEM OR EXPENSES ARISING FROM THE SOFTWARE AND RELATED DOCUMENTATION OR USE 
OF THEM. IN NO EVENT WILL Red Hen BE LIABLE FOR ANY DIRECT, INDIRECT, OR SPECIAL DAMAGES 
OR LOSSES ARISING FROM USE OR INABILITY OF USE OF THE SOFTWARE OR RELATED 
DOCUMENTATION. 

12. Red Hen reserves the right to change the Software specifications and related documentation 
without notice. 

13. This Agreement will be governed by and construed in accordance with the laws of Colorado. 

14. Export Rules - You agree that the Software will not be shipped, transferred or exported into any 
country or used in any manner prohibited by the United States Export Administration Act or any 
other export laws, restrictions or regulations (collectively the "Export Laws").  In addition, if the 
Software is identified as export controlled items under the Export Laws, you represent and warrant 
that you are not a citizen, or otherwise located within, an embargoed nation (including without 
limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited 
under the Export Laws from receiving the Software. 

All rights to use the Software are granted on condition that such rights are forfeited, if you fail to comply 
with the terms of this agreement. 
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